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1.  Introduction

1.1 APEX II Systems for Chemical 
Crystallography

Bruker AXS Kappa APEX II and SMART APEX 
II systems are the newest members in the 
Bruker Nonius product line of instrumentation 
for single crystal X-ray diffraction. The systems 
provide the tools for complete small molecule 
structure determination. The hardware and soft-
ware are completely redesigned. The software 
features a new start to finish graphical user 
interface (GUI). The hardware features a new 
CCD detector based upon four port readout of a 
4K chip and a choice of two goniometers. APEX 
II systems are enclosed in a fail-safe X-ray 
enclosure system.

The Kappa APEX II system features the Kappa 
4-axis goniometer. Two computers are used for 
experiments. One computer, the server, controls 
the goniometer. The other computer, the client, 

controls all other aspects of the experiment, 
from data collection through report generation.

The SMART APEX II system is an enhanced 
version of the SMART APEX fixed chi system. A 
single computer controls the data collection, and 
solution and refinement of the structure.

From a software and operational viewpoint, the 
APEX II systems use the GUI of the APEX2 
software suite to control all operations, from 
crystal screening to report generation, for a typi-
cal crystallography study. This is a complete 
departure from the command driven, function-
ally separate modules of SMART, SAINTPLUS 
and SHELXTL. Enhanced versions of the 
proven and widely accepted programs used by 
these modules (e.g., SAINT, SADABS, XPREP, 
XS, XM, XL, etc.) underlie the GUI and provide 
powerful tools.

From a hardware viewpoint, APEX II systems 
share common hardware components with other 
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Bruker products. Other members of this new 
generation of instruments include the D8 
ADVANCE and D8 DISCOVER, and the D8 
GADDS systems for general diffraction. Docu-
mentation on some of these common hardware 
and software components is available in the 
user’s manuals for the D8 family of instruments.

1.2 User Manual Features

This user manual and associated YLID test data 
are intended to provide you with a step-by-step 
guide to data collection and processing using 
the APEX2 software program.

The test data supplied was collected on an X8 
(or Kappa, per Ludger) diffractometer with an 
APEX II camera, and graphite monochromated 
molybdenum radiation from a sealed tube gen-
erator. The high quality data (resolution=0.75 Å) 
allows easy refinement of the hydrogen atom 
positions and determination of the absolute 
structure of the sample.

NOTE: Before using this manual, check that 
your system is in proper working order (e.g., the 
optics and goniometer are aligned) and that the 
APEX2 suite is properly installed.
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1.3 X-ray Safety

X-ray equipment produces potentially harmful 
radiation and can be dangerous to anyone in the 
immediate vicinity unless safety precautions are 
completely understood and implemented. All 
persons designated to operate or perform 
maintenance need to be fully trained on the 
nature of radiation, X-ray generating equipment 
and radiation safety. All users of the X-ray 
equipment are required to accurately monitor X-
ray exposure by proper use of X-ray dosimeters.

For safety issues related to the operation and 
maintenance of your particular X-ray generator, 
diffractometer and shield enclosure, please refer 
to the manufacturer operation manuals or your 
Radiation Protection Supervisor. The user is 
responsible for compliance with local safety reg-
ulations.
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2.  Hardware Overview

The two hardware platforms for the APEX II sys-
tems are the Kappa APEX II, the four-axis 
advanced research instrument, and the SMART 
APEX II, the three-axis laboratory instrument. 
Software functionality is essentially the same for 
both platforms.

2.1 System Components

The system (Figure 2.1 and Figure 2.2) consists 
of the following basic components.

• APEX II™ CCD detector

• 4-axis Kappa or 3-axis goniometer

• K780 X-ray generator

• Radiation safety enclosure with interlocks 
and warning lights

• D8 controller

• Refrigerated recirculator for the detector

• Computer(s) (two for the Kappa APEX II 
and one for the SMART APEX II)

• Video microscope

• Accessories (temperature devices)
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Figure 2.1 - Kappa APEX II system Figure 2.2 - SMART APEX II system
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2.1.1 APEX II Detector

The APEX II detector is specific to this system. 
Status lamps on the top of the detector housing 
indicate when the detector is on (green) and off 
(red).

On Kappa APEX II systems, the detector is 
mounted on a motorized 2θ track. The camera 
distance is computer controlled (a typical dis-
tance for the camera is 40 or 50 mm).

On SMART APEX II systems, the detector is 
mounted on a 2θ dovetail track. The track has a 
scale that is calibrated in mm to indicate the dis-
tance from the crystal to the phosphor window 
(a typical distance for the camera is 40 or 50 
mm).

2.1.2 Goniometer

The goniometer module and APEX II detector 
comprise the unique hardware of the system. 
This is the part of the instrument that actually 
performs the experiment.

Several components comprise the goniome-
ter module with APEX II detector.

• Goniometer (4-axis or 3-axis)

• APEX II detector

• X-ray source (including shielded X-ray tube, 
X-ray safety shutter, and graphite crystal 
monochromator)

• K780 X-ray generator

• Timing shutter and incident beam collimator 
(with beam stop)

• Video camera
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Kappa APEX II Goniometer

The Kappa goniometer uses a horizontally ori-
ented Kappa goniometer with 2-theta, omega, 
kappa and phi drives and a motorized DX track 
for setting the detector distance. It includes 
mounting points for the video camera and for 
optional attachments such as the optional low 
temperature attachment.

Figure 2.3 - Kappa 4-axis goniometer components

With the kappa angle, the crystal can be ori-
ented at chi from -92 to 92 °?. This leaves the 
top of the instrument open for easy access.
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SMART APEX II Goniometer

The SMART APEX II system uses a horizontally 
oriented D8 goniometer base with 2-theta, 
omega and phi drives, dovetail tracks for the X-
ray source and detector, and an additional 
mounting track for accessories such as the 
video camera and optional low-temperature 
attachment.

The 3-axis system incorporates a fixed chi stage 
with chi angle of approximately 54.74° and a phi 
drive with 360° rotation, which is so compact 
that it swings into the incident beam collimator, 
allowing free rotation in omega. All four axes 
(2θ, ω, φ, and χ) intersect.

Figure 2.4 - SMART goniometer components
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X-ray Source

Three components comprise the X-ray source: a 
shielded X-ray tube, an X-ray safety shutter, and 
a graphite crystal monochromator.

The sealed tube X-ray source, with a molybde-
num (Mo) target, produces the X-ray beam used 
by the system.

The X-ray safety shutter is built into the X-ray 
tube shield. The shutter opens upon initiation of 
a set of exposures and closes upon the end of 
collection. Status lamps on the shutter housing 
indicate when the shutter is open (red) and 
closed (green). The shutter is also interfaced to 
the controller and to the safety interlocks.

A tunable graphite crystal monochromator 
selects only the Kα line (λ=0.71073 Å) emitted 
from the Mo X-ray source and passes it down 
the collimator system.

Timing Shutter and Collimator

On SMART APEX II systems, the monochro-
matic X-ray beam then passes through the laby-
rinth, the timing shutter, and the incident beam 
collimator before striking the specimen. On 
Kappa APEX II systems, the monochromatic X-
rays pass through a small labyrinth, the timing 
shutter, a secondary labyrinth and the incident 
beam collimator before striking the sample.

• The labyrinth is a device that ensures that 
the collimator and shutter are tightly con-
nected to prevent X-ray leakage.

• The timing shutter is a device which pre-
cisely controls the exposure time for each 
frame during data collection. Its status 
lamps indicate when the shutter is open 
(ON) and closed (OFF). For SMART APEX 
II systems, this assembly also houses an 
automatic attenuator. Kappa APEX II sys-
tems do not have an attenuator.

• The incident collimator is equipped with pin-
holes at both front (near crystal) and rear 
(near source). These pinholes help to define 
the size and shape of the incident X-ray 
beam that strikes the specimen. (Collima-
tors are available in a variety of sizes, 
depending on your application.)

• The beam stop catches the remainder of the 
direct beam after it has passed the speci-
men. The beam stop has been aligned to 
minimize scattered X-rays and to prevent 
the direct beam from hitting the detector. 
The entire collimator assembly is supported 
by a collimator support assembly, which has 
been precisely aligned to guarantee that the 
X-ray beam passes through the center of 
the goniometer.
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2.1.3 Video Camera/ microscope?--heading?

The video camera, an essential part of the sys-
tem, allows you to visualize the crystal to opti-
cally align it in the X-ray beam and to measure 
the crystal dimensions and index crystal faces. 
The camera is interfaced to the computer and is 
operated through the VIDEO program. The 
video program includes several computer-gen-
erated reticules and scales to make centering 
and measuring the crystal easy.

2.1.4 K780 X-ray Generator

The K780 X-ray generator is a high-frequency, 
solid-state X-ray generator, which provides a 
stable source of power for operations up to 60 
kilovolts (kV) and 50 milliamps (mA). For the 
APEX II system, power settings should never 
exceed the maximum power rating of the X-ray 
tube.

Typical maximum power settings for the APEX II 
system with a fine focus tube are 50 kV, 40 mA. 
For both types of tubes, the kV setting should 
not exceed 50 kV and the power (kV x mA) 
should not exceed the rating given on the tube 
cap.

This generator is interfaced to the controller and 
the power settings can be adjusted within the 
APEX2 software. This is usually not necessary 
though as the software automatically increases 
the power to the user defined values at the 
beginning of an experiment and lowers them 
when the instrument is inactive.

2.1.5 Radiation Safety Enclosure with 
Interlocks and Warning Lights

A common component of all systems in the D8 
family is the radiation safety enclosure. This new 
design is fully leaded (leaded metal sides and 
panels, leaded windows) to protect you from 
stray radiation. The enclosure also includes 
warning lamps (a government requirement) that 
alert you when X-rays are being generated. 
And, as a special feature, the enclosure incorpo-
rates interlocks (for both hardware and soft-
ware)—an automatic system-interruption device 
that senses when the doors and panels are 
open and prevents use of the shutter and data 
collection until you close the doors.

2.1.6 D8 Controller

The D8 controller is an electronic module 
enclosed in the rack behind the font panel of the 
instrument. It contains all of the electronics and 
firmware for controlling the generator, opening 
the X-ray shutters, and monitoring other instru-
ment functions, such as safety interlocks, gener-
ator status, and detector statuses. For SMART 
APEX II systems, the goniometer is controlled 
by the D8. For Kappa APEX II systems, there is 
an additional module, the Kappa controller, for 
positioning the Kappa goniometer angles and 
driving the detector distance.
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2.1.7 Refrigerated Recirculator for the 
Detector

The refrigerated recirculator uses an ethylene 
glycol/water mixture to absorb the heat from 
dual Peltier devices which are used to cool the 
CCD chip to approximately -58°F (-50°C). This 
minimizes dark current.

2.1.8 Computers

The Kappa APEX II system uses two high 
speed computers. The server controls the 
instrument and is used for crystal centering and 
screening. The client collects the data, stores 
the raw frames, processes the data, and solves 
and refines the structure. The two computers 
are linked via a hub and communicate with each 
other via TCP/IP protocols.

The SMART APEX II system uses a single high 
speed computer for control of the experiment, 
storage of raw frame data, integration of the 
data, and solution and refinement of the struc-
ture.

Often the computer(s) is (are) attached to a net-
work of similarly configured computers with 
access to local and/or network printers.

NOTE: Connection to the external network must 
be done with care. Consult with local security 
experts.

2.1.9 Accessories

Various devices can be mounted on the goniom-
eter base. These include optional low- and high-
temperature attachments. Both instruments can 
be used with diamond-anvil cells.
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3.  Software Overview

This section presents an outline of the system 
software, including a brief description of the soft-
ware layout, as well as the graphical user inter-
face (GUI).

APEX2 runs on two computers: the server and 
the client. For SMART APEX II systems, the 

server and the client execute on the same com-
puter, but the functionality remains separate. 
The flowchart in Figure 3.1 shows the software 
layout. For both Kappa APEX II and SMART 
APEX II systems, the server and client commu-
nicate using TCP/IP protocol. 

Figure 3.1 - APEX2 software diagram
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3.1 The Server Computer

The server computer communicates with the 
hardware, allowing the user to control the instru-
ment. The software to align the system, as well 
as to align and screen samples, runs on the 
server computer.

3.1.1 Bruker Instrument Service (BIS)

BIS provides the link between the hardware and 
software. Once a connection is established, BIS 
executes hardware commands sent by the 
APEX2 software. The instrument service can 
also be used as a service tool, displaying diag-
nostic messages during operation.

Figure 3.2 - Image of start/stop in BIS

3.1.2 Bruker Control Program (BCP)

BCP is used to configure BIS, as well as to pro-
vide instrument control and alignment tools. 

Figure 3.3 - BCP main window



APEX2 User Manual Software Overview

M86-E00078 3 - 3

3.1.3 APEX2 Server

The APEX2 Server provides tools for aligning 
and screening samples. There are two main 
items: Align Crystal and Simple Scans (see Fig-
ure 3.4).

Figure 3.4 - Simple Scans window
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3.2 The Client Computer

The client can be any computer which is on the 
same network as the server. For SMART APEX 
II systems, it is usually the same computer as 
the server. The main portion of the APEX2 suite, 
the APEX2 client, runs on the client computer. 
The client is a GUI with multiple plug-ins or mod-
ules for different aspects of an experiment. The 
client includes a database which stores relevant 
data from each step in the experiment. Details 
of the functions available in the GUI will be 
explained in more detail later in the manual.

3.2.1 Database and Database Connection

As currently configured, the database is used 
internally by the APEX2 Suite and is not avail-
able for user customization or manipulation. It 
must be running before the APEX2 Suite is 
started and it should be stopped before the 
computer is shutdown (see Section 4.3.2).

The purpose of the database is for storage of 
data generated by the Bruker APEX2 software. 
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3.2.2 APEX2 GUI

The APEX2 GUI has one main window (see Fig-
ure 3.5). This window is divided into four sec-
tions:

• Window Tool Bar

• Tool Icon Bar

• Task Bar

• Task Display Area

Figure 3.5 - APEX2 GUI
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Window Tool Bar

The tool bar provides pull-down menus for a 
variety of file operations, image tools, and help 
files.

Tool Icon Bar

The tool icon bar provides shortcuts to the 
options available through the window tool bar.

Option Description

[Symbol] Use this menu to select the following: 
Restore, Move, Size, Minimize, Maxi-
mize, and Close.

File Use this menu to select the following: 
Login, Logout, New, Open, Save, Close, 
Import (Spatial), Export (P4P File) and 
Exit.

Instrument Use this menu to select the following: 
Connection, Status, Toggle Shutter and 
Abort.

Windows Use this menu to select the following: 
Cascade and Tile.

RLATT
(available when 
you select 
Reciprocal
Lattice Viewer)

Use this menu to select the following: 
Rotate, Edit, Orientation, Unit Cell Tool, 
Measure Distance, Measure Angle and 
Visualization.

View
(available when 
you select Data 
Collection 
Strategy)

Use this menu to select the following: 
Detailed Strategy.

Table 3.1 – Window tool bar options

Icon Description

Create a new file.

Open a file.

Save a file.

“What’s this?” -- context-sensitive help.

Open an image.

Select previous image. This icon is visible 
only when an image is open.

Select next image. This icon is visible only 
when an image is open.

Draw a circle. This icon is visible only when 
an image is open.

Table 3.2 – Tool icon bar options
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Task Bar

The task bar provides menus for all of the 
options in the APEX2 Suite: crystal evaluation 
and indexing (Evaluate Crystal), data collection 
(Collect), data processing (Integrate and Scale), 
and instrument setup (Instrument).

Draw a plotting line. This icon is visible only 
when an image is open.

Change the part of the image displayed while 
zoomed in. This icon is visible only when an 
image is open.

Select a region of the image. This icon is visi-
ble only when an image is open.

Icon Description

Table 3.2 – Tool icon bar options

Setup

Describe - Specify crystal size, color, 
shape, etc.

Center - 

Evaluate Crystal

Determine Unit Cell - Determine unit cell 
and Bravais lattice type.

Reciprocal Lattice Viewer - 3D visualization 
of lattice projected in reciprocal space.

Table 3.3 – Task bar options
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Collect

Data Collection Strategy - Simulated data 
collection and determination strategy.

Experiment - Sequence editor for data col-
lection experiments.

Oriented Scans - Measure different images 
with the crystal aligned along the axes.

Integrate

Integrate Images - Integration of different 
data.

Scale

Scale - Scale intensities and perform 
absorption correction.

Examine Data

Table 3.3 – Task bar options

XPREP (Space Group Determination) - 
Run XPREP.

Precession Images - Create synthesized 
precession images based on measured 
frames.

Solve Structure

Structure solution.

Refine Structure

Report

Run XCIF to generate a report.

Instrument

Table 3.3 – Task bar options
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Task Display Area

The task display area is the main area for tasks, 
user input and selected output. This area dis-
plays images, the reflections used in indexing, 
and the observed and predicted diffraction pat-
terns. It also displays the runs for data collection 
and solution and refinement. (For version 1.22, 

space group determination, SaintChart output, 
XShell refinement, and Xcif report generation do 
not use the Task Display Area; they open in a 
new window). All other plug-ins open in the Task 
Display Area of the GUI.

Figure 3.6 - The Task Display area showing COSMO
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4.  Program Start-Up and Shutdown

As mentioned previously, the APEX2 Suite is 
composed of several programs. All of the pro-
grams are started in a similar fashion. For ease 
of use there is usually a desktop icon for the 
folder containing these programs and desktop 
icons directly to these programs. However the 
Click on Start > Programs > Bruker … path is 
always available. This more complicated method 
is what will be used in this discussion.

4.1 Server Computer Start-Up

Two programs must be running: Bruker Instru-
ment Service and APEX2 Server.

NOTE: For Kappa APEX II systems, the pro-
grams will be on the server computer in the 
goniometer cabinet. For SMART APEX II sys-
tems, there is typically only one computer.

4.1.1 Starting Bruker Instrument Service 
(BIS)

1. Click on Start > Programs > Bruker AXS 
Programs > Bruker Instrument Service.

After a brief initialization period, a window will 
appear (see Figure 4.1). On Kappa APEX II sys-
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tems, the goniometer will move to reference 
positions.

Figure 4.1 - The BIS window

If a small pop-up window appears that says 
“This second instance of BIS is exiting” (see Fig-
ure 4.2), BIS was already running. Click on ok to 
clear this informational message.

Figure 4.2 - BIS warning message

NOTE: With a SMART APEX II or a Kappa 
APEX II, the kappa goniometer will home and 
the kappa server will activate when BIS is 
started. This may take a minute or two. The 
server is a service tool and should not be used 
to control the instrument.
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4.1.2 Starting the APEX2 Server

1. Click on Start > Programs > Bruker Nonius 
Programs > APEX2 Server.

A window will appear (see Figure 4.3).

Figure 4.3 - Initial APEX2 Server window

2. In the top left corner, click on the pull-down 
menu Instrument (see Figure 4.4). 

Figure 4.4 - Connecting to the instrument

3. Click on Connection and a new window will 
appear (see Figure 4.5). The name of your 
server should already be filled in.

4. Click on connect. 

Figure 4.5 - Connection window

NOTE: If the name is wrong then the instrument 
is not properly configured and you should con-
sult the system manager. (It is possible to con-
figure the instrument to automatically connect 
and then this window will not appear). tell how 
to do this.
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4.2 Client Computer Start-Up

On the client computer, two programs are also 
required: the database and APEX2. It is best to 
start the database before starting APEX2.

NOTE: For the SMART APEX II, there is typi-
cally only one computer for the client and server 
software.

4.2.1 Starting the Database

1a. For Windows systems, click on Start > Pro-
grams > Bruker AXS Programs > Start 
Database or click on the Start Database 
icon on the desktop.

1b. For Linux systems, open a terminal window 
and type “bnrun startdb” or click on the Start 
Database icon.

A window should appear that says the database 
system is ready.

Figure 4.6 - The database is ready

You can minimize this window. If the database 
has not previously been closed properly (e.g., 

after a power failure), a window will appear (see 
Figure 4.7) that states that another postmaster 
is running. If this happens, stop the database 
and then start it again.

Figure 4.7 - Database failure message

4.2.2 Starting APEX2

1a. For Windows systems, on the client com-
puter click on Start > Programs > Bruker 
Nonius Programs > APEX2 or click on the 
APEX2 icon on the desktop.

1b. For Linux systems, open a terminal window 
and type bnrun apex2 or click on the APEX2 
icon.
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2. A window will appear to login to the data-
base by entering a user and password (see 
Figure 4.8).

2.1 If the system manager has set up the 
system to automatically enter the user 
name and password, step 2 is skipped. 

Figure 4.8 - Login request

3. An empty start-up window will appear (see 
Figure 4.9).

Figure 4.9 - APEX2 start-up window

4. Click on File. 

Figure 4.10 - clickfile2.bmp

5. Use the options in this menu to create a 
new project or to open an existing project.

6. If the window in Figure 4.11 appears then 
APEX2 thinks the database is already in 
use. Answer “Yes” to close the window.

Figure 4.11 - Sample Locked menu
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4.3 Client Computer Shutdown

NOTE: The order of stopping these programs is 
important. If you attempt to close the database 
before APEX2 is stopped, the database will 
remain open until APEX2 is stopped.

4.3.1 Stopping APEX2

1. For Windows or Linux systems, click on the 
X in the upper right corner of the window or 
click on File > Exit in the upper left. It is not 
necessary to disconnect from the instru-
ment.

4.3.2 Stopping the Database

1a. For Windows systems, click on Start > Pro-
grams > Bruker Nonius Programs > Stop 
Database or click on the Stop Database 
icon.

1b. For Linux systems, in a terminal window 
enter bnrun stopdb or click on the Stop 
Database icon.

A window will appear and quickly disappear, and 
the Start Database window will close.

Figure 4.12 - Stop database screen

NOTE: Occasionally the windows won’t disap-
pear and the Start Database window will display 
a “smart shutdown request” (see Figure 4.12). 
This message means that the database is wait-
ing to close until applications that it might write 
to are closed. Exit APEX2 to solve this problem. 
If the message still appears, check for other pro-
cesses that may still be running (e.g., COSMO).
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4.4 Server Computer Shutdown

Stop APEX2 Server before BIS. It is ok if the 
order is inverted. Generally, BIS is never 
stopped.

4.4.1 Stopping the APEX2 Server

1. Click on the X in the upper right corner of 
the window or click on File > Exit in the 
upper left. It is not necessary to disconnect 
from the instrument.

4.4.2 Stopping BIS

It is almost never necessary to stop and exit 
BIS. If necessary, click on the stop BIS button 
on the bottom of the BIS window and then click 
on the exit button at the bottom of the window.
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5.  Crystal Orientation

We are now ready to begin data collection with 
the instrument using the YLID test crystal. We 
assume that your system manager has set up 
the system properly and that all system default 
parameters have been set appropriately.

The data collection process is divided into five 
steps:

See Section 5:

1. Centering/aligning on the diffractometer 
(from the APEX2 Server—the center mod-
ule)

2. Crystal quality check (from the APEX2 
Server—the simple scans module)

See Section 6:

3. Cell determination (from APEX2—the cell 
determination module)

4. Data collection setup (from APEX2—the 
strategy module)

5. Data collection (from APEX2—the experi-
ment module)

The first steps, mounting, aligning and screen-
ing a crystal, are performed on the server com-
puter.
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5.1 Mount the Goniometer Head on 
the Instrument

Use extreme care when handling the 
goniometer head to prevent damage to your 
sample on the end of the small glass fiber.

1. Open the enclosure doors. Push either of 
the rectangular green Open Door buttons on 
the side posts. This will release the door 
locks for approximately five seconds. During 
this time, pull out on one or both of the han-
dles to physically open the doors.

2. In the APEX2 Server GUI, under Setup click 
on Center Crystal.

The centering buttons will appear and the video 
window will open.

Figure 5.1 - 

The bottom five buttons will drive the goniometer 
to various predefined positions that are 
designed to simplify crystal centering. The top 
two buttons will drive phi by either 90 or 180 
degrees.

3. Click on Mount to mount an empty goniome-
ter head and determine the position.

NOTE: On Kappa APEX II systems, in the 
mount position, the key or pin on the mounting 
base will be toward the back of the instrument. 
On SMART APEX II systems, at φ=0°, the key 
on the mounting base of the goniometer head 
will be at the 12:00 position.

Use extreme care when handling the 
goniometer head to prevent damage to the 
sample on the end of the small glass fiber.

4. Carefully remove from its case the goniome-
ter head containing the YLID test crystal.

5. Place the goniometer head onto its base on 
the phi drive, aligning the head’s key slot 
with the key (pin) in the base.

6. Snugly screw the head’s collar to the base 
so the head does not move. Do not over-
tighten it.
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5.2 Center and Align the Sample

To obtain accurate unit cell dimensions and to 
collect good quality data, align the center of the 
sample with the center of the X-ray beam and 
maintain the alignment for the entire experi-
ment. Your video camera should be aligned so 
the crosshairs of the video camera coincide with 
the center of the goniometer and the center of 
the X-ray beam (see manual M86-Exx024 for 
instructions on aligning the microscope to the 
center of the instrument). Although, if the micro-
scope is not centered, you can still align the 
sample—the key here is that the crystal stay in 
the same place in the microscope in all orienta-
tions.

NOTE: On SMART APEX II systems, adjust the 
height while in the mount position.

NOTE: Use the thin end on the goniometer 
wrench to unlock the adjustment slides at the 
beginning of the centering process and to lock 
them at the end—locking needs only a very 
slight touch. The other end of the wrench is 
used to make adjustments.

NOTE: If the image of the crystal is difficult to 
see, illuminate the sample with a high-intensity 

lamp and/or temporarily place a light-colored 
piece of paper on the front of the detector.

NOTE: Centering is often easier if the crystal is 
rotated to give a good view before the actual 
centering process is started (e.g., down an edge 
for a plate). To do this, drive to one of the cen-
tering positions, loosen the screw that locks the 
goniometer head, rotate the crystal to a suitable 
orientation and then tighten the screw again.

1. Click on the Center button—the crystal and 
goniometer head will be positioned perpen-
dicular to the microscope. To center the 
sample, make adjustments in the height and 
with the translation screw that faces the 
front of the diffractometer.

Figure 5.2 - Crystal initially mounted
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2. Use the z-axis (translation) screw and the x- 
or y-axis (translation) adjustment screw that 
is perpendicular to the microscope axis to 
move the crystal so it is centered in the 
microscope (see Figure 5.8 and Figure 5.9).

2.1 (For the SMART APEX II) Make adjust-
ments in the x and y translations, but 
not to the height (z).

Figure 5.3 - Crystal centered

3. Adjust the height with the z-axis screw.

3.1 (SMART APEX II) Click on the Right 
button. Adjust the height and the trans-
lation screw that is facing up.

4. Adjust the translation with the x- or y-axis 
screw, whichever is pointed toward you.

5. Adjust the height again with the z-axis 
screw.

6. Adjust the crystal position using the x- or y-
axis screw.

7. Click on Drive Phi 180 and adjust (adjust 
what? x/y) again.

Figure 5.4 - Drive Phi 180

8. Check the other translation. (how? which 
one?)

Repeat steps 3 and 4 as necessary to keep the 
crystal in-line with the microscope.

9. Click on Drive Phi 90.

Figure 5.5 - Drive Phi 90
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Repeat steps 6 and 7 as many times as neces-
sary to keep the crystal in the same place in the 
microscope.

10. Adjust the crystal position using the goniom-
eter screws. Why adjusting now--what are 
we adjusting?

11. Click on Drive Phi 180 and adjust again. 
(adjust what? x/y)

Repeat steps 3–11 as necessary until x is cen-
tered. Then adjust the height using the following 
steps.

1. Click the Left button and note the height. 
The goniometer drives to place the fiber 
horizontal and to the left.

2. Click the Right button and check that the 
crystal height stays in the same place in the 
microscope.

2.a If the height is in the same place, you 
are done.

2.b If the height is not in the same place, 
adjust the height and repeat steps 1 
and 2.

Figure 5.6 - Check the crystal height

3. Click the Top button.

Figure 5.7 - The crystal is centered

The crystal is now centered on the instrument. 
All of the next steps (except removing the crys-
tal from the diffractometer) are performed with 
APEX2 on the client computer.
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Figure 5.8 - Huber goniometer head in detail
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Figure 5.9 - Standard goniometer head in detail
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6.  Data Collection

The data collection process is carried out on the 
client computer using APEX2. Once data collec-
tion is started, exit APEX2. Data collection will 
continue.

6.1 Start a New Project and 
Describe the Sample

1. Left-click on File > New.

2. In the window that appears enter the sample 
name.

Figure 6.1 - The New Sample window

3. Click OK.

4. The task bar will appear with the Setup sec-
tion open. Left-click on Describe.
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5. Enter the requested information into the 
Describe window.

Figure 6.2 - Describe window

6. Close this module. The data will automati-
cally save to the database.
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6.2 Determine the Unit Cell

6.2.1 Collect Images

1. In the task bar, left-click on Collect and then 
on Experiment

Since there was no connection to the instrument 
when APEX2 was started, the program recog-
nizes that it needs a connection in order to col-
lect images. It will ask to connect (see Figure 
6.3). 

Figure 6.3 - Instrument Connection window

2. Click on Connect.

3. Click on Append Matrix Strategy at the bot-
tom left of the window.
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Figure 6.4 - Append matrix runs

1. Adjust the scan time and scan width if 
desired. The default values are usually 
good. The default time of 10 seconds is 
acceptable for most samples, but shorter 
times will not adversely affect most experi-
ments.

2. Click on Execute/Resume. The view will 
shift to the Monitor Experiment view (see 
Figure 6.5). The program will collect a 
series of three runs with twelve frames per 
run. This typically takes less than ten min-
utes. The images will stop changing when 
the experiment is done.

NOTE: Adjust the time (upper right) to match the 
scattering ability of the crystal (e.g., shorter 
times for strong diffractors and longer exposure 
times for weak diffractors). If the exposure times 
are five seconds or less, click on the check mark 
by Correlate Frames to turn off this feature. 
Frame correlation measures each frame twice 
at typically 1/2 the time and then combines the 
two together. This is usually not necessary with 
shorter exposure times.

NOTE: The format for frame names is shown in 
Figure 6.5. Every frame is assigned a name. For 
this figure the name is 
ylid_manual_01_005.sfrm. This means that the 
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frame is for the project ylid_manual and that this 
is the fifth image of the first run.

Figure 6.5 - Monitor Experiment view

Left and right 
arrows move 
between frames

Up and down 
arrows move 
between runs
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To change the color of the image display (e.g., 
Black on White), right-click in the intensity bar to 
the right of the image display (see Figure 6.6).

Figure 6.6 - Color tool

After the first run is completed, there usually is 
sufficient information to start the indexing step.

If state “usually” then need to give informa-
tion about what to do if there isn’t enough 
information.

NOTE: APEX2 assigns to every collected frame 
a name. Per Ludger, base-
name.run#.frame#.sfrm

6.2.2 Harvest the Reflections

1. Left-click on Evaluate Crystal > Determine 
Unit cell.

Figure 6.7 - The Determine Unit Cell (Indexing) icon
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This will open the image viewer, but with a tool 
bar to the right for indexing (see Figure 6.8). The 
plug-in initializes with the first run (e.g., 
matrix_01).

Figure 6.8 - Image viewer with indexing tool
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2. The name of the first image is already 
entered. Click on Harvest Spots.

NOTE: All other options are gray at this point 
because there are no reflections available.

A blue progress bar will appear as the software 
determines the best background level to use for 
harvesting. Then a window with two sliders will 
appear.

Figure 6.9 - Indexing sliders

The right slider selects which image is dis-
played. The left slider increases or decreases 
the I/s(I), the cut off criteria for accepting reflec-
tions. Generally, the defaults are fine.

3. Change the run number in the “First Image” 
box to matrix_02_0001 and click on Harvest 
Spots. The run number is 02. The image or 
frame number is 0001.

At this point you should have 100 to 300 reflec-
tions harvested.

4. Change the run number in the “First Image” 
box to matrix_03_0001 and click on Harvest 
Spots.

NOTE: If run three is not completed, a window 
will pop-up that says “Do you want to continue 
with the images that could be read?” If this hap-
pens, skip step 3 and go to Section 6.2.3. Then 
return to Section 6.2.2 and harvest the spots 
before refining.
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6.2.3 Index the Reflections

1. Click on Index.

A window will open.

Figure 6.10 - Indexing tool

The defaults are usually OK. Use the slider to 
omit reflections with lower I/sigma from the cal-
culations. If indexing is difficult, try reducing the 
number of reflections used.

If indexing is difficult, use the RLATT tool. This 
tool is described in Appendix ?.

2. Click on Index.

After approximately 30 seconds the index win-
dow will display a possible cell and the OK but-
ton will no longer be gray. The values shown in 
Figure 6.11 are reasonable for the ylid.

Figure 6.11 - The unit cell

The spot statistics are also acceptable with 98% 
(i.e., (238/244)x100) of the selected spots 
indexed.

Figure 6.12 - Focus on the spot results

There are often a few reflections that are not 
indexed. The reciprocal lattice viewer can be 
used to look at the spots used in the indexing, 
but first refine this cell.

3. Click on OK to accept the indexing results.
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6.2.4 Refine the Unit Cell

There is not a correct order for the following 
steps. Use this as a guideline with the main goal 
of creating a stable converged refinement.

1. Click Refine in the Indexing Tools menu. 
The refinement window will open.

Figure 6.13 - The Refine menu with histograms displayed
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The YLID test crystal should have an orthor-
hombic primitive cell with approximate cell 
dimensions of a=5.95Å, b=9.03Å, c=18.38Å, 
and α=β=γ=90°.

2. Click View Histograms. The histograms 
show how observed data compares to the 
data calculated using the current unit cell. 
The HKL values should be close to integers 
and the rotation angle differences should 
not be significantly larger than the step size 
used to collect the matrix frames.

3. Click Refine several times.

4. Check the Constrain Distance and Con-
strain Beam Center boxes.

NOTE: Check the constraints to fix the parame-
ters listed. Uncheck the constraints to allow the 
parameters to refine.

5. Uncheck Constrain Pitch, Roll, and Yaw.

6. Click Refine several times.

7. Uncheck Constrain Distance and Constrain 
Beam Center, and check Constrain Pitch, 
Roll, and Yaw.

8. Click Refine several times.

NOTE: In most cases, the angle zeroes are 
close to zero and should not be refined. The 

crystal should now be aligned, so refinement of 
the crystal center is not necessary.
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6.2.5 Determine the Bravais Lattice

1. After refining, click Bravais Lattice and look 
for other unit cell choices (i.e., look at fit val-
ues).

Figure 6.14 - Bravais lattice display

Note that even though monoclinic has a slightly 
better fit, the software makes the correct choice 
of the higher symmetry cell.

2. Click on the appropriate Bravais Lattice, in 
this case orthorhombic.

3. Press OK to accept the suggested lattice 
settings.

4. Refine again.

5. Refine for several more cycles, changing 
the constraints one or two at a time.

Now you have a unit cell ready for determining a 
data collection strategy.
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6.3 Determine the Data Collection 
Strategy

APEX2 includes a powerful algorithm, COSMO, 
for determining an efficient strategy that fully uti-
lizes the flexibility of your instrument.

1. Left-click on Collect > Data Collection Strat-
egy.

Figure 6.15 - The strategy display
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NOTE: COSMO will use information from cell 
determination to set defaults. You can modify 
the suggested values. How?

2. Check the inputs for defining the data col-
lection.

2.1 Set the data collection distance. For 
SMART APEX II systems this should be 
set to the actual detector distance. For 
Kappa APEX II systems there is a vari-
able (DX) and the distance will default 
to the shortest reasonable distance. 
Generally for the APEX II detector, the 
distance should be about the same as 
the longest cell dimension. Typically 
distances ranging from 35 to 45 are 
reasonable.

2.2 Set the exposure time and press return. 
For normal crystals on an APEX II, five 
seconds is a reasonable time.

2.3 Click Same to set all of the times to be 
the same.

NOTE: If the “Same” feature is not chosen, the 
times for shells can be set to collect high 
angle data more slowly than inner shell data.

2.4 Set the desired redundancy (0.50 is a 
reasonable value).

2.5 Check the other values (Laue class, 
Lattice, etc.).

2.6 Each time a value is changed, COSMO 
recalculates the statistics for the runs. 
The results are displayed in the column 
labeled Current.

2.7 Below the Target and Priority columns 
is a pull-down menu with several differ-
ent strategies. Choose the one that 
best meets the needs of the experiment 
(for the example, “Best in 2 hours”).-
-cut this text, we don’t need to give a 
step by step analysis of the YLID.

At this point, if all of the runs available were col-
lected it would take 183.98 hours and get a 
redundancy of 452.86. Clearly this is not desir-
able.

3. Click on Refine Strategy.

4. A list of options will appear. Again click 
Refine Strategy.

Figure 6.16 - UserManual017.bmp

NOTE: The objective in refine strategy 
(COSMO) is to get good completion (98% or 
better) with high redundancy in a reasonable 
amount of time. When COSMO is first started it 
will tell you the completion, redundancy, and 
time for all of the available runs. It is almost 
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never necessary to let COSMO run to comple-
tion. Typically it should be stopped when com-
pletion is greater than 99% and the time is close 
to what is desired.

 

Figure 6.17 - Completeness and redundancy chart
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In this example, as shown in Figure 6.18, the 
completion is 99.76% and the time is approxi-
mately 2.33 hours.

NOTE: Time estimates are approximate. They 
depend on the number of rescans, general 
instrument overhead, backlash compensation, 
etc. If estimated times are consistently longer or 
shorter, modify the COSMO hardwire profile.

5. Click Stop when the completeness nears 
100% and the time and redundancy 
approach the desired values. It is not neces-
sary to wait until the refinement reaches 
100%.

Figure 6.18 - Strategy status and priority control

6. Click Refine Strategy.

7. A list of options will appear. Click on sort 
runs for completion.

Figure 6.19 - Choose “Sort Runs for Completeness”
Figure 6.20 - UserManual022.bmp
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8. Go to View > Detailed Strategy.

The next window shows the runs to be collected.

 

Figure 6.21 - 

NOTE: If for some reason it is necessary to start 
over, change the distance slightly (by 0.02 for 
example) and press Return. COSMO will reload 
all of the possible runs.

You are now ready to collect data.



Data Collection APEX2 User Manual

6 - 18 M86-E00078

6.4 Data Collection/Run Experiment

1. Click Collect > Experiment.

2. Go back into the experiment window and 
delete the three matrix runs if they are still 
there.

Figure 6.22 - UserManual014.bmp

3. Click Append Strategy.
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4. The program changes the name to the 
name of the current project (in this example, 
ylid_manual).

Figure 6.23 - Experiment view with strategy appended
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NOTE: At the top of the experiment window are 
controls for data collection. Usually the default 
values are correct. For data collection times of 
less than five seconds, correlation can usually 
be turned off. If new dark frames are required, 
APEX2 will automatically collect them. Checking 
“Generate New Darks” will force the collection of 
darks before every run. In Figure 6.23, the time 
and width are explicitly set for each run, so 
changing the default width and time will have no 
affect. If the explicit time or width for a run is 
deleted so the box is empty, the default values 
will appear and be used.

5. Click Execute/Resume. The focus will shift 
to Monitor Experiment and images will start 
to appear. This may take a minute or two if 
new darks are being collected. Images will 
start to appear.

NOTE: When resuming after a power failure, 
APEX2 will automatically skip images that were 
previously collected with matching angles and 
generator settings. Otherwise it will ask if you 
want to overwrite the images.

NOTE: After data collection is started, the 
experiment window can be closed and APEX2 
can be stopped. The server computer must be 
left on. If communications are lost between the 

client and the server, frame data is stored on the 
server.

Figure 6.24 - Monitor experiment view
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7.  Data Integration and Scaling

Before the data can be used to solve and refine 
the crystal structure, convert the information 
recorded on the frames to a set of integrated 
intensities and scale all of the data.
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7.1 Integration

1. Click on Integrate in the Task Bar.

2. Click on the Integrate Images icon. The fol-
lowing window will open.

Figure 7.1 - Initial integration window

3. Check the default values.

There are two items of interest on the top of the 
window. The space group tool and the resolu-
tion limit value.

Figure 7.2 - The space group tool
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The space group tool allows the user to set the 
symmetry for integration. Typically this value is 
correct when the integration window opens.

Figure 7.3 - Choosing P2(1)2(1)2(1) with the space group 
tool

The resolution window on the upper right sets 
the upper resolution for integration.

Figure 7.4 - The resolution tool

The APEX2 Suite will suggest a resolution cut-
off. In this case the suggested value changed to 
0.75.

In the center of the bottom are two buttons for 
defining the data collection runs to be inte-
grated.

Figure 7.5 - The Find and Import Runs buttons

The import runs button determines the runs to 
be integrated from the experiment that has just 
been submitted. Using this button allows the 
user to start integration while the data is still 
being collected.

NOTE: SAINT will integrate all of the data cur-
rently measured and then will wait for the next 
image, integrate that, and wait for the next, etc.

The Find Runs button is used to browse to the 
set of runs to be integrated. The button is nor-
mally used when the data collection is finished.
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1. Click on Find Runs.

The following window will open, usually it will 
have the correct directory and basename as the 
defaults. If these are not correct, then use the 
browse button to find the runs for the data col-
lection of interest.

Figure 7.6 - Find Runs tool view

Both the Import Runs from Experiment and the 
Find Runs buttons will generate a list of runs as 
shown in Figure 7.7.

Figure 7.7 - Completed runs list

Figure 7.7 shows a run list entry being changed. 
The original run is shown first and then the run 
with the starting image number modified. In the 
last strip, the number of frames to process has 
been changed.
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Double-click on any of the fields in this list to 
open up that value for editing.

Figure 7.8 - Example of manually editing a run list

2. Check the refinement defaults.

The two buttons on the bottom far left are used 
to change the default options for the refinement 
of the data.

The default values are generally very good. 
There is seldom any need to change those in 
the refine window.

Figure 7.9 - Refine Window

3. Change the default options for the integra-
tion in the “Integration Options” window.

The integration window has a few values that 
are changed more frequently.

Figure 7.10 - Integration Options
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The default values in the Model Profiles window 
are usually good.

Figure 7.11 - Model Profiles

For weakly diffracting crystals it is sometimes 
helpful to change some options in the Model 
Profiles window. Reducing the Intensity/Sigma 
ratios from 10 and 9 to, for example, 5 and 4 or 
3 gives the profile fitting algorithm more reflec-
tions to model. Clicking on Blend Profiles from 
All Detector Regions to increase the profile 
blending can also help with weakly diffracting 
crystals.

4. Click on More Options. This results in an 
expanded window (see Figure ) and gives 
access to several other useful features, in 
particular Active Mask (see Figure 7.13), 
Algorithm (see Figure 7.14), and Image 
Queue (see Figure 7.15).
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Figure 7.12 - The Integration Options window with “More 
Options” selected
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7.1.1 Active Mask

Figure 7.13 - The Active Mask tool

The Active Mask is used to mask out areas that 
are covered by the beam stop, low temp nozzle 
or other obstructions. Typically a value of 0.7 is 
good here. SAINT will determine an active mask 
for each run.

NOTE: If this option is set, the user should 
examine the active mask images that are written 
into the work directory. These images can be 
opened with the image viewer. They should be 
all red except for a black area showing the 
shape of the obstruction, typically the beam 
stop.

7.1.2 Algorithm

Figure 7.14 - The narrow/wide algorithm tool

The algorithm buttons are used to change from 
narrow to wide frame integration. Frames col-
lected with narrow scans width (less than one) 
should be integrated as narrow frames. Those 

greater than one should be integrated as wide 
frames.

7.1.3 Image Queue

Figure 7.15 - The Image Queue tool

The Image Queue sets the number of frames 
being used to determine profiles. For crystals 
with high mosaic spread (big wide reflections) 
increasing the queue size can improve integra-
tion.

5. Click on the button on the far right of the 
bottom row, Start Integration. This will start 
the integration and will open the SaintChart 
window for monitoring the integration.

6. Examine the output. Double-click on any of 
the output entries for one additional tool—
the ls button at the far right of the top. This 
will open the SAINT listing file for that inte-
gration run (see Figure 7.16).

Figure 7.16 - Using the runs list ls tool
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7.2 Monitor the Integration Run with 
SaintChart

SaintChart is a powerful tool for monitoring the 
progress of the calculation and for graphically 
presenting the results of the integration process.

 

Figure 7.17 - SaintChart view
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As shown in Figure 7.17, when the SaintChart 
window opens the graphs are small, and under 
Linux the text area is large.

1. Change the view.

1.1 Change the text area by clicking and 
dragging on the line between the text 
and graphical areas.

1.2 Expand the windows to fill the available 
graphical area by clicking on the four-
square icon in the upper right.

Figure 7.18 - SaintChart view with graphical area expanded
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To the left of the graphical area are a series of 
check boxes that select the displays.

1. Add other displays.

1.1 Click on integration progress to add the 
new display seen in Figure 7.19. When 
the integration is complete, the blue 
progress bars will be full and the 
remaining time will be zero.

Figure 7.19 - Integration progress display
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One of the most powerful windows for monitor-
ing the progress of the integration is Spot Posi-
tion Overlay (in Per-Image Statistics). Pull up on 
the Window Tool Bar for Integrated Spots (the 
cursor arrow is pointing to this tool bar in Figure 
7.20) to display the entire window (see Figure 
7.21).

Figure 7.20 - Spot Position Overlay
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In this full view, the Integrated Spots window 
looks much like the image viewer used previ-
ously, but there are no tools. At the bottom of 
the window is an entry box that can be used to 
change the display frequency of the Integrated 
Spots images. The default is shown every fifth 
image.

Figure 7.21 - Full view of the Spot Position Overlay
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1. Examine SAINT text output.

At the bottom of the SaintChart window is a 
scrolling text window that displays the text out-
put from Saint. (This window can be expanded 
by dragging the horizontal bar above the text as 
indicated by the arrow in Figure 7.22).

2. Examine the final results.

At the end of the integration, examine this text 
critically. In particular, look at the Overall Rsym, 
the coverage statistics and the unconstrained 
unit cell refinement.

For a typical small molecule structure, the over-
all Rsym is usually less than 8%. Higher values 
may indicate problems with absorption, twinning 
or poor crystal quality.
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7.2.1 Overall Rsym and Coverage Statistics

Figure 7.22 - Final Saint Integration Statistics

Add text.



Data Integration and Scaling APEX2 User Manual

7 - 16 M86-

7.2.2 Unconstrained Unit Cell Refinement

Figure 7.23 - Unconstrained unit cell refinement

Check the angles in the unconstrained unit cell 
refinement to get a quick confirmation that the 
initial lattice determination was correct. In the 
unconstrained refinement, angles that are 
required to be 90 or 120 are allowed to refine. If 
they differ considerably from the expected value 
then the data should be checked carefully.
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7.3 Scale

The scaling process uses the SADABS program 
to put all of the measured data on the same 
scale. This process involves five steps:

1. Setup input files.

2. Parameter refinement.

3. Error model refinement.

4. Display diagnostics.

5. Exit.

7.3.1 Setup Input Files

1. Click on Scale > Scale in the task bar. Fig-
ure 7.24 shows a portion of the initial Scale 
work area. The defaults and file names are 
typically correct.

Figure 7.24 - FIG7.28a

2. Click Next and check that the defaults are 
correct. Generally the Absorber Type is all 
that changes.
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7.3.2 Parameter Refinement

1. Click on Refine. Figure 7.25 shows a typical 
refinement result. The R-values are reduced 
and the Mean weight increases. Typical 
final values are 3–4% for the R-values and 
0.95–0.98 for the Mean Weight.

Figure 7.25 - Xscale window after refinement
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7.3.3 Error Model Refinement

Figure 7.26 shows typical Error Model results.

Figure 7.26 - Error model results

NOTE: If the R-values are significantly higher 
than this step, repeat the entire scaling calcula-
tion. Click the check box by the “bad” run and 
then click Repeat Parameter Refinement.
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7.3.4 Display Diagnostics

1. Click Finish to produce a series of diagnos-
tic plots. Some of these are recaps of the 
plots that have already been displayed.

2. Click on the “folder” tab at the bottom of the 
screen to select the individual plots as 
shown in Figure 7.27. Why? To do what?

Figure 7.27 - Tabs for selecting diagnostic plots



APEX2 User Manual Data Integration and Scaling

M86-E000787 - 

The Scale Variations plot shows the overall vari-
ation in Scale and R(int) for the individual 
frames. The Scale plot should be flat (for highly 
absorbing, irregularly shaped crystals it will 
probably be sinusoidal) and the R(int) plot 
should not show large variations (more than 
2%).

Figure 7.28 - Overall scale and R(int) variations
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The Intensity Statistics plots look at R(int) and 
|E2-1| as a function of resolution. Typical plots 
of R(int) versus Resolution increase to the right 
as seen in Figure 7.29. An |E2-1| plot should 
have a constant resolution. |E2-1| is a strong 
indicator of centric and acentric space groups. 
The two horizontal lines indicate the expected 
values for centric (top) and acentric (bottom) 
space groups. This plot clearly suggests an 
acentric space group.

Figure 7.29 - Intensity Statistics

The plots Chi-Squared values for the data as a 
function of resolution and intensity should be 
mostly flat. Values below one are not unusual 
for weaker high resolution data. The plots 
shown in Figure 7.30 are typical.

Figure 7.30 - Chi-squared
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The special distribution plots are generated for 
each data collection run. They indicate, using 
red and blue dots, points of average intensity for 
a particular reflection after scaling. The actual 
intensity measured at that spot on the detector 
vary by more than three standard deviations. 
Figure 7.31 show two spatial distribution plots 
side by side. This is the way they are typically 
output by Scale.

Figure 7.31 - Spatial distribution
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Figure 7.32 shows a single plot so that the dots 
are easier to see. Note that the points of dis-
agreement are spread fairly evenly over the 
entire detector face.

Figure 7.32 - A single Spatial Distribution

If the spots are clustered in an area or if there 
are significantly more spots of one color than 
there are of another, then the data should be 
examined critically. Figure 7.33 is from another 
data set where the active mask was not used 
during integration and the reflections collected 
in that area are consistently smaller than 

expected. This kind of problem may affect the 
final results.

Figure 7.33 - A Spatial Distribution plot showing a problem 
area
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7.3.5 Exit

1. Click on Exit XScale to close the scaling 
GUI.

Figure 7.34 - Exit XScale

NOTE: Scale is one of the few GUIs where it is 
necessary to exit using a special exit button. 
This avoids an error message that SADABS has 
exited improperly.
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8.  Examine Data

In this step, the space group for the sample is 
determined and optional simulated precession 
photographs are calculated to further evaluate 
the overall quality of the data. APEX2 provides 
two tools for this: XPREP for space group deter-
mination and Precession Images for looking at 
undistorted slices of reciprocal space. This is 
the final step before beginning the structure 
solution and refinement process.

8.1 XPREP

1. Click on XPREP (Space Group Determina-
tion) under Examine in the task bar.

2. Check that the two files in the pop-up win-
dow are correct (see Figure 8.1) and click 
OK.

Figure 8.1 - Select files for XPREP input

NOTE: The scaling process has created two 
files: ylid_manual_0m.p4p containing the final 
unit cell parameters from integration and 
ylid_manual_0m.hkl containing the corrected 
intensities. Typically these are the files to use for 
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space group, but you can browse to choose 
other files.

8.2 Space Group Determination

1. XPREP evaluates the data and looks at the 
mean intensities and the mean int/sigma. 
Since these are large for all groups except 
P, XPREP suggests that the lattice is P (see 
Figure 8.2). Press Enter to accept.

Figure 8.2 - Lattice statistics

2. XPREP determines the reduced cell based 
on the lattice entered above. Since the lat-
tice was primitive and the magnitudes of the 
cell dimensions were proper (a<b<c), the 
original and reduced cells are the same 
(see Figure 8.3). Press Enter to search for a 
higher symmetry cell.

Figure 8.3 - Reduced cell

For the YLID, there is no higher symmetry cell 
found. The program has determined that the 
YLID crystal has an orthorhombic primitive lat-
tice (see Figure 8.4). Press Enter to accept.

Figure 8.4 - Higher symmetry cells
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3. The next logical step is to determine the 
space group. XPREP suggests this (see 
Figure 8.5). Press Enter to determine the 
space group.

Figure 8.5 - Determine the space group

4. If the space group is known or if the com-
pound is known to be chiral, enter that infor-
mation (see Figure 8.6). Generally, it is 
sufficient to press Enter to start the space 
group determination.

Figure 8.6 - Space group options

5. XPREP has chosen the crystal system [O] 
(see Figure 8.7). Press Enter to accept.

Figure 8.7 - Choose the crystal system

6. XPREP has chosen the crystal lattice [P] 
(see Figure 8.8). Press Enter to accept.

Figure 8.8 - Choose the lattice

7. XPREP evaluates the data and looks at the 
systematic absences for all possible glide 
planes and screw axes (see Figure 8.3). 
These are displayed across the middle of 
the figure. By examining the number of 
reflections with I>3 sigma(I), the mean 
intensities, and the mean int/sigma, which 
should all be very small for a systematic 
absence, XPREP derives a suggested 
space group, P2(1)2(1)2(1). Press Enter to 
accept.
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8.3 Reflection Statistics.

Figure 8.9 - Systematic absences and a suggested space 
group

1. XPREP returns to the general menu seen 
previously (see Figure 8.5). This time D is 
chosen to evaluate the dataset. Press Enter 
to accept.

2. There are multiple choices for data manipu-
lation (see Figure 8.10). “S” chooses a dis-
play of statistics.

Figure 8.10 - The data manipulation menu

3. The data can be merged in several ways. 
Choose the merge all equivalents including 
Friedel mates option [A] (see Figure 8.11). 
Press Enter to accept.

Figure 8.11 - The merge data menu

4.  A table of statistics appears (see Figure 
8.12). Examine the data presented. Is the 
completion near 100%? Is the redundancy 
good? Are Rint and Rsigma small and 
increasing smoothly from top to bottom? In 
particular look at the last two lines which 
compares all of the data with the high reso-
lution data. The completion should be near 
100% for both the high resolution shell and 
the complete data set. The redundancy and 
Rint should be similar for the two. The Mean 
Intensity and the Mean I/sigma(I) will usually 
be quite different. The Mean I/sigma(I) for 
the high resolution data should be greater 
than 3.0.
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For this data set the difference between the Rint 
for the high resolution data and the complete 
data set is slightly larger than expected. Press 
Enter to continue.

Figure 8.12 - Intensity statistics

5. Since the difference between the Rint for 
the high resolution data and the complete 
data set is slightly larger than expected, it is 
reasonable to apply a high resolution cutoff 
using the H option in the data manipulation 
menu. (see Figure 8.13). Type H and press 
Enter.

Figure 8.13 - Requesting a high resolution cutoff

8.4 Applying High Resolution Cutoff

1. Enter a high resolution limit of 0.75 (see Fig-
ure 8.14) and press Enter to accept the low 
resolution cutoff of infinity.

Figure 8.14 - The resolution cutoff menu

2. Applying the cutoff removes approximately 
3000 reflections from the data set (see Fig-
ure 8.15). The next step is to see if the cut-
off has improved the statistics. Type S and 
press Enter.

Figure 8.15 - Requesting statistics after applying a high 
resolution cutoff

3. As before in step 3, enter [A] to merge all 
equivalents.
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4. After the cutoff, all of the statistics look bet-
ter (see Figure 8.16). Press Enter to con-
tinue.

Figure 8.16 - Statistics after high resolution cutoff

5. This response will return to the data manip-
ulation menu (see Figure 8.10, Figure 8.13 
or Figure 8.15). The default answer should 
be E for exit. Press Enter to accept this 
default.

8.5 Preparing an Output File

1. Exit the data manipulation menu to return to 
the general menu. This time chose C to 
define the unit cell contents.

2. A window will open displaying the current 
formula, Z, the density and the atomic vol-
ume (see Figure 8.17). In this example, the 
formula is incorrect and Z has been set to 
six to try to achieve a reasonable density 
and atomic volume. Since this formula is 
incorrect it must be modified now. The cor-
rect chemical formula for the YLID crystal is 
C11 H10 O2 S.

2.1 At Select Option do not accept the 
default answer of E. Type in F to enter a 
new formula.

2.2 In response to the question “Enter For-
mula,” type the correct formula C11 
H12 O2 S1 and press Enter.

2.3 Check that the information is correct. 
Check that Z seems reasonable for the 
space group, that the density is as 
expected (1.1 to 1.4 for organic mole-
cules, higher for inorganic compounds), 
and that the atomic volume is around 
17 or 18. Significant variation from the 
expected values may indicate an incor-
rect molecular formula or missing 
counter ions or solvates. The values at 
the bottom of the window look fine for 
the YLID. Press Enter to accept.
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Figure 8.17 - Defining and checking the unit cell contents

3. The next default action for XPREP is to 
write out the files necessary for the structure 
solution process (see Figure 8.18). Press 
Enter to accept.

Figure 8.18 - Requesting output files
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4. The program asks for an output file name. 
Since this data has been cutoff at a resolu-
tion of 0.75A, it makes sense to change the 
output file name to ylid_res75 to reflect the 
cutoff (see Figure 8.19). Press Enter to 
accept.

Figure 8.19 - Changing the file name

5. After entering the file name (or hitting return 
to accept the default file name) an input file 
for the structure solution module is created 
and displayed on the screen. And the pro-
gram asks “Do you wish to (over)write the 
intensity data file ylid_res75.hkl.” Since the 
file name has been changed, this question 
must be answered with a y (see Figure 
8.20).

Figure 8.20 - The input file for structure solution and a final 
question

6. Exit XPREP (see Figure 8.21). Press Enter 
to exit the program.

Figure 8.21 - Exit XPREP from the general menu

NOTE: There are many other features in 
XPREP that can be accessed from the general 
menu; reciprocal space plots, simulated powder 
patterns and a test for merohedral twinning are 
very useful tools.
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8.6 Simulated Precession Images

1. Click on Precession Images under Examine 
in the task bar. Precession Images provide 
an undistorted view of layers of the recipro-
cal lattice. APEX2 generates simulated pre-
cession images by finding the appropriate 
pixels in a series of “.sfrm” images. You 
must specify the images to examine and the 
zones to calculate.

Figure 8.22 - The simulated precession work area

2. To open the file selection window, left-click 
on the folder beside the file name. Choose 
the sets of images that you want to use for 
the calculation by clicking on the check 
boxes (see Figure 8.23).

Figure 8.23 - File Selection window with matrix runs 
deselected

3. Check the default input value. Modify as 
needed and press Calculate.

Calculating more zones does not significantly 
increase the calculation time. In the example, 
1kl, h1l and hk1 have been added to the 
defaults of 0kl, h0l and hk0. Fractional values 
(e.g., 0.5kl) are allowed. Reducing the resolu-
tion may speed the calculations slightly. The 
thickness defines the range of pixels above and 
below the requested range. For example, if the 
0kl zone is requested with a thickness of 0.1 
then the simulation is looking for all pixels that 
have -0.1<h<0.1, and any value, including frac-
tional values, for k and l.
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Figure 8.24 - Detail of the input section

4. A progress bar will appear and after approx-
imately 5–10 minutes (depending on the 
number of “sfrm” files read) an image will 
appear on the screen. Display other planes 
by clicking on the calculated images to the 
bottom right of the work area or by browsing 
as usual with the view plugin.

Figure 8.25 - The progress bar

NOTE: This is a relatively slow calculation since 
every sfrm file is examined to determine if it has 
pixels that would contribute to a requested zone. 
For example, if the 0kl zone is requested with a 
thickness of 0.1 then the simulation is looking 

for all pixels to have -0.1<h<0.1 and any value, 
including fractional values, for k and l.

5. User the simulated patterns to check space 
group symmetry (see Figure 8.25, Figure 
8.26 and Figure 8.27) and to find signs of 
twinning (see Figure 8.28).

I am having trouble generating acceptable 
images for 8.26 to 8.29, but they will get done 
eventually.

Include SIMPREC5.bmp here 

Figure 8.26 - The 0kl plane for the test YLID 

Include SIMPREC6.bmp here 

Figure 8.27 - The h0l plane for the test YLID

Include SIMPREC7.bmp here 

Figure 8.28 - The hk0 plane for the test YLID

Include SIMPREC7.bmp here 

Figure 8.29 - A plane from a rotationally twinned crystal 
showing the two lattices

Curt will add images of a good and bad exam-
ple.
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9.  Structure Solution and Refinement

9.1 Overview

You are now ready to solve and refine the crys-
tal structure for the YLID test crystal. The vari-
ous steps in solving and refining the structure 
are carried out within the APEX2 GUI. These 
tools will prepare input files for the solution and 
refinement programs of the SHELXTL package. 
The integration process (SAINT) has produced 
two important files—YLID1M.p4p, containing 
the final unit cell parameters and other impor-
tant information on how the experiment was car-
ried out, and YLID1M.raw, containing the actual 
intensity data.

These files are all that is required to begin the 
structure solution and refinement process. The 
various steps in solving and refining the struc-
ture are carried out using the programs of the 
SHELXTL package.
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9.2 Solve the Structure

The process of obtaining an initial model of the 
compound is started by clicking in the Task Bar 
on Solve Structure and then on Structure Solu-
tion.

1. This will open the Structure Solution GUI. 
Check that there is a reasonable formula in 
the formula window.

1.1 If you entered a correct formula in the 
display GUI, then all is ready to start a 
normal direct method run.

1.2 If the formula is incorrect, change it in 
the formula window and press Return. 
The input file will update.

Figure 9.1 - Default Solve Structure view



APEX2 User Manual Structure Solution and Refinement

M86-E00078 9 - 3

2. Click on Solve Structure to start the calcula-
tions and open an output window. This win-
dow can be used to monitor the progress of 
the direct methods calculations.

Figure 9.2 - Structure Solution output

3. Click on the arrow to the right of Direct 1 in 
the Method box (see Figure 9.3). This gives 
three choices for structure solution using 
direct methods.

Figure 9.3 - Method box

In most cases the default values will give a good 
initial model, but there are several other options 
available for more difficult problems.

1. Chose the solution method by clicking the 
appropriate radio button on the left in the 
Method box.

2. Highlight and click on Direct 1 to set up a 
default run with a simple TREF instruction.

3. Highlight and click on Direct 2 to set up an 
extended run with TREF 10000. By adding 
10000 to the TREF command, more 
attempts are made to determine a solution. 
This will take more time, but if you see a 
good solution in the output window it is pos-
sible to stop at that point by clicking on the 
STOP button. Good solutions typically have 
a CFOM of 0.06 or less.

4. Highlight and click on Direct 3 to set up an 
extreme run with two instructions, ESEL 1.0 
and TREF 100000. By adding ESEL 1.0, 
more reflections are used in the solution 
process. This is particularly useful for acen-
tric triclinic structures and for pseudo sym-
metric structures. Increasing the number of 
tries in the TREF command to 100000 runs 
until ended by clicking on the STOP button. 
There is only one predefined option for the 
dual space calculations and also only one 
for the heavy atom Patterson methods.

At the end of the direct methods runs, the output 
display will look like the figure. Good figures of 
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merit are near 1.0 for Sigma-1 and M(abs) and 
less than 0.06 for Ralpha and the CFOM. Struc-
tures can be solved with figures of merit that 
deviate from these numbers, but they may 
require more effort.

If all looks reasonable, click OK in the output 
display and Exit in the solutions plug-in. The 
next step is structure refinement using XSHELL.

9.3 XSHELL

9.3.1 Refine the Structure

The structure solution step produced statistics 
that indicate a solution had been found. The real 
proof is in the initial model that is produced. 
XSHELL provides the tools to view the model 
and determine if it makes chemical sense.

1. Start XShell, the molecular viewing and 
refinement plug-in, by clicking on Refine 
Structure in the Task Bar and then on the 
Structure Refinement icon.

2. This will open a window to select files for 
XShell. In usual operations, the file name 
will be preselected. If a different file is 
desired, select Browse.

Figure 9.4 - The Select Files tool
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3. Click on OK to open a molecular display 
window.

Figure 9.5 - Initial view of the YLID molecule
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4. Right-click in the background to open a pop-
up window with options to change the 
image.

Figure 9.6 - XSHELL menu
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The Information On All Atoms option shows a 
list of the peaks and their heights. The drop in 
height between Q13 (the last real peak) and 
Q14 (the first noise peak) is typical of a correct 
solution.

Figure 9.7 - Atom information screen

At the bottom left of this window is a slide bar 
which is used for deselecting peaks. The arrow 
can be moved by left-clicking and dragging the 
arrow or by left-clicking on either side of the 
arrow. Left-clicking to the left of the arrow (i.e., 
where the cursor is pointed in Figure 9.8) will 
remove peaks.

Figure 9.8 - The Q-peak slider

5. Slide the pointer down while watching the 
molecular display. Change the number of Q 
peaks to 15.
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At 15 the molecule is much cleaner, but there 
are still peaks that do not make sense.

Figure 9.9 - Image after the number of Q peaks was 
changed to 15

Two more clicks left on the Q-peak slider gives a 
reasonable model.

Figure 9.10 - Image with all noise peaks removed

6. Put the cursor over the bonds to check dis-
tance. The distance will be displayed at the 
bottom right. The distance of 1.178 is typi-
cal for C=0 in aromatized ring systems.
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9.3.2 Label the Atoms

1. Label the atoms and set the atom types. 
Left-click on atoms to select them. Left-click 
on the peaks for the two oxygen atoms (Q2 
and Q5 in this example).

Figure 9.11 - View of model with the probable oxygen peaks 
selected
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2. If it is difficult to see the color and labels, 
change the color scheme by left-clicking on 
Preferences and then right-clicking on 
Background Color. Choose colors and click 
Apply. Click Cancel to exit the background 
color mode. Note that the selected peaks 
are blue in Figure 9.13.

Figure 9.12 - Selecting the background color
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Figure 9.13 - New background color

3. Right-click to view a pop-up menu and 
select Labelling.

Figure 9.14 - Select Labelling

The Atom Labelling box will open.

Figure 9.15 - Atom Labelling box

4. The two selected atoms need to be 
changed to oxygen atoms. Do this one of 
two ways:

• Click on the Element field and type in the 
element symbol (case does not matter).

• Click on the El button to the right of the Ele-
ment field. This will open a periodic table. 
Left-click on the appropriate element sym-
bol to select it (the periodic table will auto-
matically close).
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Figure 9.16 - Refine014

5. Once the element type is set correctly, click 
on Relabel to number the peaks sequen-
tially in the order they were selected starting 
with the number in the First Sequence # 
field.
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6. Seeing the color of atoms can be difficult in 
the Wireframe view used so far. Right-click 
in the background with no atoms selected to 
get a slightly different action menu. In this 
menu, highlight and left-click on Pipes. This 

makes the bonds thicker and makes it obvi-
ous that there is an incorrectly labeled atom. 
That will be corrected when the carbon 
atoms are labeled.

Figure 9.17 - Choose the pipes view

7. Left-click on the remaining peaks in the 
order that you want them labeled.

NOTE: If working on the YLID test data, look at 
Figure 9.18 and click on the peaks to give the 
same order as used here. Right-click and 
choose Labelling. Select Carbon and apply the 
labels.

8. In the labelling tool, change the el type to C 
(carbon). The starting atom number will 
change to 1—the first available number for 
carbon atoms.

9. Click Relabel.

10. Click Cancel to close the window.
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9.3.3 Refine the Molecule

The labeled ylid molecule is now ready for 
refinement.

Figure 9.18 - Correctly labeled model

1. Left-click on the Refine icon in the tool bar 
(the cursor is pointing to it in Figure 9.19) or 
Type Control+R.

Figure 9.19 - The Refine icon
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This will open the Refine Box. Click on Refine to 
launch the least-squares refinement program, 
XL using the default parameters as given.

Figure 9.20 - The Refine menu

After a few seconds, a Refine window will open 
with output results for the calculation.

Figure 9.21 - Isotropic refinement output

In the output displayed above, note that the R1 
value is 0.08. This is typical for a preliminary iso-
tropic refinement for an organic molecule with 
data to a resolution of 0.75 and no hydrogen 
atoms included. The refinement program also 
indicates that the model needs to be inverted to 
get the correct absolute structure.

NOTE: This indication of the absolute configura-
tion is usually reliable, but all assignments of 
absolute structure should be confirmed later in 
the refinement process by including TWIN and 
BASF cards in the instruction input.
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2. Click on OK to return to XShell. The mole-
cule display will refresh with the results of 
the least-squares calculations.

Figure 9.22 - The model after isotropic refinement

The peaks in the diagram represent difference 
in the electron density between the refinement 
model and the experimental electron density as 
defined by the measured data. Many of these 
difference peaks are near the sulfur and oxygen 
atoms. Refinement of all atoms anisotropically 
should correct the model.

In the refinement box click on Invert Structure 
and Refine All Non-H Atoms Anisotropically as 
in Figure 9.23.

Figure 9.23 - Inverting and choosing anisotropic refinement
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3. Click on the Refine button to launch the 
least-squares refinement program. The out-
put window will open and a summary of the 
results of individual cycles of refinement will 
appear.

Figure 9.24 - Refine023

The value for R1, 0.047, is typical for an initial 
anisotropic refinement with no hydrogen atoms 
included. Since the mean shift/esd is greater 
than 0.1, the model is still changing. Since the 
highest peak in the difference map has a height 
of 0.49 and is 0.5A from C10, there are certainly 
some hydrogen atoms to be included.
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Examination of the difference peaks in the 
resulting difference electron density map shows 
that the top difference peaks all correspond to 
hydrogen atoms.

Figure 9.25 - Difference peaks correspond to expected 
hydrogen atom positions
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9.3.4 Look at Atomic Displacement 
Parameters (Thermal Ellipsoids)

It is generally good practice to examine the dis-
placement parameters at this point in structure 
determination.

1. Remove difference peaks with the slider 
tool.

Figure 9.26 - Removing all Q-peaks with the slider bar

2. Right-click on the background and select 
Thermal Ellipsoids.

Figure 9.27 - Selecting Thermal Ellipsoids

Figure 9.28 - Refine2015

Alternatively, a list of Ueq’s (equivalent isotropic 
displacement parameters) can be generated by 
requesting information on all of the atoms. 
Examining these values for outliers is good 
practice.

3. Right-click on the background and click on 
Information on All Atoms.

Figure 9.29 - refine 2005
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This produces the table in Figure 9.30.

Figure 9.30 - List of parameters with Ueq to the right

Examining the values here is difficult because 
the atoms are not in order.
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9.3.5 Sort Atoms

1. Right-click on the background and click on 
“Sort…” to sort the atoms into a sensible 
order.

Figure 9.31 - Choose the Sort option

A box will appear to the right of the molecule 
display. Since S1, O1 and O2 are in a reason-
able order, only the carbon atoms need to be 
ordered.

Figure 9.32 - refine2016

NOTE: Generally, it is easier to sort and number 
atoms before adding hydrogen atoms.

2. Highlight the atoms to sorted (i.e., left-click 
and drag over the atoms) and move them to 
the sort bin (i.e., left-click on Move Selected 
Atoms to Sort Bin).
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Figure 9.33 - refine2017

3. After the atoms are in the sort bin, click on 
Sort(Alpha-Numeric) to get them into a nor-
mal order.

4. Highlight O2 and click on Insert All After 
--- > as in Figure 9.34.

Figure 9.34 - refine 2019

5. Click on OK to accept the sorting.

Figure 9.35 - refine2011
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The resulting list of atom information is easier to 
examine.

Figure 9.36 - Sorted atoms

The Ueq are reasonable if there are:

• lower values for the sulfur atom and the five 
member ring

• higher values for the terminal atoms—meth-
yls and carbonyls

• sensible numbers for the six member ring— 
lower for C8 and C9 higher for C5 and C6 
and in between for C4 and C7

9.3.6 Add Hydrogen Atoms

At this point, refine the hydrogen atoms either 
by renaming them using the labelling tool as 
before and then including them in the refine-
ment.

or

Include the hydrogen atoms in fixed idealized 
positions riding on the atom to which they are 
attached.

In this manual we will illustrate the later fixed 
idealized method.

NOTE: In some cases (e.g., hydrogen atoms on 
hetero atoms or on geometrically strained car-
bon atoms), it is better to refine the hydrogen 
atom positions. A general rule is to refine if there 
is some doubt about the position of the hydro-
gen atom and there is different electron density 
present.
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1. Using the slider tool, remove all of the 
hydrogen atoms.

Figure 9.37 - Retread model with difference peaks removed

2. Right-click in the background and the click 
on Hybridize All.

Figure 9.38 - Refine025

The colors of the atom labels will change to indi-
cate the atom hybridization.

NOTE: If the atom hybridizations are hard to 
see, right-click on the background and open the 
Information on All Atoms window.

Figure 9.39 - Refine028

Figure 9.40 - Model with added Hydrogen atoms

3. The following warning will appear indicating 
that the hydrogen atoms have been provi-
sionally added and that the final addition 
with naming will take place when the least-
squares calculations are started. Click OK.

Figure 9.41 - Hydrogen atom warning
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4. Click on the Refine button to launch the 
least-squares refinement program. The out-
put window will open and a summary of the 
results of individual cycles of refinement will 
appear.

Figure 9.42 - Refinement results

The value for R1, 0.029, is typical for an aniso-
tropic refinement with riding hydrogen atoms 
and a data set measured to 0.75Å. Since the 
mean shift/esd is less than 0.01, the model is 
not changing significantly. Since the highest 
peak and the deepest hole in the difference map 
are similar there are probably no missing atoms.

The resulting difference electron density map 
appears rather ugly. This is because the number 
of difference peaks to be displayed has been left 
at 20.

Figure 9.43 - Difference peaks in a well refined model

9.3.7 Final Refinement for Publication

1. For the final cycles of refinement reduce the 
number of peaks to be displayed to five and 
turn on Use Suggested Weights and Gener-
ate ACTA(CIF) Information File as shown in 
the next two figures.

NOTE: If the suggested weights vary signifi-
cantly from 0.06 and 0.00, then change the val-
ues to 0.06 and 0.00.

Figure 9.44 - Refine032
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Figure 9.45 - Select weights and request ACTA output

2. Click on Edit File, choose INS and click OK 
to open the instruction file for the XL. This 
allows you to add instructions that are not 
directly available in the GUI.

Figure 9.46 - Open the .ins file for editing

3. Check that the temperature card is correct.

3.1 If torsion angles are of interest, add a 
CONF (confirmation).

Figure 9.47 - Add instructions in the .ins file

Figure 9.48 - Difference peaks

4. Display the anisotropic atoms displacement 
parameters for the YLID.

5. If planarity and angles between planes are 
of interest, add mpla cards.
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9.3.8 Generate an Atomic Displacement 
(Thermal Ellipsoid) Plot

1. Remove difference peaks with the slider 
tool.

2. Right-click on the background and select 
Thermal Ellipsoids.

Figure 9.49 - Thermal ellipsoids with large hydrogen atoms

3. If the hydrogen atoms in Figure 9.49 are 
large, change their size.

3.1 Click on preferences in the Window 
Tool Bar and choose Atom Prefer-
ences.

Figure 9.50 - Atom preferences tool

At the top of the box that is opened there are 
three values that can be changed to change the 
size of atoms and the bonds to them.

Figure 9.51 - Default atom preferences

4. Change the hydrogen radius to 0.08 and the 
bond radius to 0.15 to make the hydrogen 
atoms smaller.

Figure 9.52 - Modified atom preferences

Figure 9.53 - Thermal ellipsoid plot with smaller hydrogen 
atoms
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5. Position atom labels by right-clicking on the 
atom and choosing Position Label.

Figure 9.54 - Position Label menu

Figure 9.55 - Positioned labels

6. Convert this image into a high quality jpeg 
for inclusion into reports by clicking on ren-
der in the Windows Tool Bar and choosing 
Black and White to High Quality JPEG file.

Figure 9.56 - Generate JPEG

NOTE: A message may appear that the font file 
needs to be defined “Please set your font direc-
tory for the first time for opengl rendering.“ If this 
happens, click on Preferences > OpenGL Pref-
erences. Then click on the true type font 
For.OpenGL. In Windows browse to 
C:\bn\xshell\fonts\ or in Linux go to /usr/local/
bin/xshell/fonts. Choose a font.
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Figure 9.57 - The final rendered thermal ellipsoid/atomic 
displacement parameter plot
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Appendix A.  SAINTPLUS

Occasionally it is necessary to integrate images 
outside of the APEX2 GUI. Usually this is nec-
essary in order to import a matrix (p4p) file. 
SaintPlus executed from a command window is 
designed for this purpose.

1. Open a Command Prompt window.

2. Change directories to the folder of interest.

3. For Windows, enter the command 
bnrun c:\bn\src\plugins\saint\saintplus.pyc 

(see Figure A.1). For Linux, enter the com-
mand bnrun /usr/local/bn/src/plugins/saint/
saintplus.pyc.

Figure A.1 - Starting SAINTPLUS
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After the command is executed, the SaintPlus 
window will open (see Figure A.2).

Figure A.2 - Initial integration window

This window is like the Saint window discussed 
previously, but with the following differences:

• Defaults are not determined by previous 
knowledge of the sample.

• There is a button to replace the matrix files.

4. Click Find Runs.

5. Browse to find the images to integrate.

Figure A.3 - Find Runs tool view

6. Click on Replace Matrix Files and browse to 
find a p4p or spin file to use.

Figure A.4 - Find Matrix tool view

7. This defines the information on the runs, but 
the defaults for space group and resolution 
have not been updated. Click on space 
group and select the correct space group, in 
this case Pmmm.
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Figure A.5 - Space group tool

8. Double-click on the Resolution Limit and 
enter an appropriate value.

NOTE: If the starting values for SAINT need to 
be changed frequently, change the default by 
modifying the SAINT.ini file. Consult the SAINT 
manual 269-0175xx for further information on 
Windows or Linux.

9. Use the Refinement Options and Integration 
Options buttons to set up the Saint run. In 

this case Generate Active Mask has been 
turned on and set to 0.7.

Figure A.6 - Active Mask tool

10. Click on Start Integration to start the calcu-
lations and open the SaintChart window for 
monitoring the results.
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Appendix B.  Crystal Screening

crystal selection and mounting
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Appendix C.  RLATT

1. Use the Reciprocal Lattice tool to look at the 
reflections.

Figure C.1 - UserManual013.bmp
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Index

DPS

HKL

Kaercher Strategy

ProScale

SADABS

SAINT+

SMART

Sparks indexing

XM 

XPREP

Curt--I’ll add to this list of keywords. If there are 
any you specifically want added, write them in.
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